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 Preface 
 Manual information 

Purpose 
This manual details operation of the SMART Gateway 

  

Audience 
This manual is written for the engineers and technicians that are 
responsible for the proper installation and use of SMART. 

  

Revision history 
Edition Date Revision 
0.1 3-11-2014 First draft 
0.2 25-11-2014 Final 
1.0 25-10-2016 Update to V2.3 
1.1 22-11-2016 Update to V2.4  
1.2 17-07-2017 Update to V2.6 
1.3 21-05-2020 Update to V3.x 

 

  

Writing styles 
To make this document easier to understand, this manual contains 
the following text styles: 
 
Style Description 
Bold Chapter titles, paragraph titles, table 

headers. 
Italic bold Special words that need emphasis 
CAPS Indicates a keystroke on the keyboard, 

such as ENTER, CTRL, SHIFT or ALT. 
> Indicates the direction of navigation 

through a menu structure.  
Display Indicates a setting and setting value 

 

           Note 
 
 

 
Indicates important information that helps 
to avoid problems. 
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 1. Introduction 
 To be able to provide good quality of service for program delivery 

to end users in the digital broadcast domain, it is important to 
receive early warning indication in case of problems during 
provisioning or run of these programs. The SMART DVB probe is a 
system which serves as such an early warning system.  

The SMART DVB probe is a comprehensive product designed to 
provide real-time analysis and monitoring of DVB compliant 
Transport Streams. The probe provides Table, Service, PID, and bit 
rate analysis for a complete overview of the incoming Transport 
Stream. The probe provides PCR and TR 101 290 (ETR-290) 
analysis to assist in identifying problems in the transport stream. 
These features, along with real-time decoding of the incoming 
digital video and audio, provide a powerful and portable analysis 
and monitoring solution. 

  
SMART probe and 

gateway 
The SMART DVB system is divided into two functional blocks; the 
first block is the Probe and the second block is the Gateway. The 
Probe is the device which performs all necessary measurements 
selected by the operator. One probe system can handle multiple 
transport streams. Depending on the amount of transport streams, 
one or more probes shall be applied to the system design. Each 
SMART DVB Probe can forward alarms and status (MIB) via 
SNMP to an overall customer management system. 
 
Important note: If other applications are installed or running on the 
probe server, they can have serious impact on the probe 
measurements. Please be aware that no other applications should be 
run on the probe, other than the installed Probe/Gateway software 
itself. 
 
The Gateway server collects all alarms initiated by one or more 
probes. The Gateway server enables the operator to view and 
publish reports of all parameters monitored by the probes.  
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 2. The SMART probe 
Key Features 

 
 
 
 

 Real time monitoring solution for traditional broadcast systems 
and IP TV systems 

 PSI / SI completeness checking 
 Threshold definition of measurements 
 MPEG-2 SD/HD and MPEG4 part 10/AVC SD/HD and HEVC 

SD/HD support 
 Live video channel matrix including EPG and UMD 

information 
 Easy to integrate with overall network managements systems 
 Black frame detection 
 Freeze frame detection 
 TR 100 290 measurement 
 SCTE35 recognition with full parsing and logging 
 Report generation 

  

Monitoring  The system can monitor different inputs like ASI and IP 
 Supports offline TS analysis 
 Monitoring of all components available in a transport stream 

(e.g. Video, Audio, Teletext, Data and ECM components) 
 Snapshot functionality on existing components 
 Snapshot for min/max bit rates per component 
 Data freeze detection 
 Scheduled measurements 

  

PSI/SI checking  Snapshot measurement for PAT, PMT, CAT, BAT, NIT actual, 
NIT others, SDT actual and SDT other, TDT and TOT table 

 MPE / DSMCC component recognition 
 Snapshot measurement per table for descriptors in the first and 

second loop 
 EIT actual P/F content check with respect to the current time 
 EIT actual scheduled content check with respect to the current 

time 
 Minimum gap definition which is allowable within the EIT 

information 
 Version number checking per table as part of the snapshot check 
 XML export of all PSI/SI tables 
 Repetition rates definition per table with lower and upper 

thresholds 
 XML table & descriptor definition of (private) tables/descriptors 

  

Decoding  I frame only decoding 
 Full frame decoding 
 Freeze frame detection (including threshold) 
 Black frame detection (including threshold) 
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 Audio silence detection 
 Audio amplitude check 
 

  

Front end  ASI 
 TSoIP (UDP, RTP, RTP+FEC) 
 Satellite, DVB-S / DVB-S2 
 Terrestrial, DVB-T/T2 
 Cable, DVB-C 

  

Reporting  Creates report per transport stream. Standard template 
generation, including time, date, alarm level, transport stream    

 Reporting functions for alarm history, service information, pid 
plan information, bitrate information, SCTE35 and system 
configuration 

 The reports can be generated either in the screen mode or PDF 
format 

  

Views  PCR views 
 Several bit rate views 
 Bit rate history 
 EPG views 
 Several alarm views at different levels 
 Monitor view, with alarm indication 
 Packet view 
 Section View 
 MIP section view 
 INT view 
 MPE view, 
 IP statistics 
 Availability graph 
 Several SCTE35 views at TS, Service and Component level 
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3. Starting Gateway ACC server 
Gate way icon & Gate 

way Desktop icon of SMART gateway ACC  

 
 
Splash start-up screen of SMART gateway ACC 
 

 

To connect to probes 

 4. Connecting to Probes 
Connecting to the 

Probe List 
To connect to probes for access and alarm collection the probe IP 
address(es) are required. In order to connect to the probes navigate 
from the menu bar to Tools  Probes. 
 

 
  

Probe connection 
details 

The probes list pops up detailing all currently connected probes. To 
add a probe click ‘Add’. Enter the IP address as below. Hit ‘Get’ to 
collect the name of the probe. This also indicated an operational 
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connection at this stage. Now click OK. The probe will be seen in 
the Probes list. Repeat to add more probes. 
 

 
  

 To remove a probe, highlight the device and select remove, you will 
be prompted for conformation. 
 
Existing probes addresses can be reconfigured using the ‘edit’ 
option.  
 

 
 

System time 

 

           Note 
 
 
 
In a distributed SMART DVB environment, be sure that the system 
time of all the probes and the ACC system are equal. The local time 
of the ACC system is recommended. All the alarm timestamps are 
based on the probe system time. 
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5. NOC View 
ACC User NOC 

Interface 
When the ACC is started, the NOC User Interface is shown. The 
ACC NOC User Interface is shown in figure below. 
 

 
 
The ACC NOC view, is designed to give a total status overview of 
all TS-ses within all probes that are connected. 
 
 

TS Button View 
When the ACC is started, the NOC User Interface is shown. The 
ACC NOC User Interface is shown in figure below. 
 

 
 
The ACC NOC view, is designed to give a total status overview of 
all TS-ses within all probes that are connected. 
The TS Button view shows all the transport streams, as coloured 



 

12 

SMART Gateway operation manual 

buttons. Each TS button is displayed with the colour of its highest 
alarm category. 
 
A button can have 2 states: 

 
- Engaged (pressed):  
The “Current Alarms” view on the bottom panel includes all 
alarms of the corresponding TS. 
 
 
 -Disengaged: 
The “Current Alarms” view on the bottom panel does not 
include all alarms of the corresponding TS. 
 

The “All” button selects all transport streams for alarm viewing. 
Holding ‘CTRL’ and engaging transport allows multiple selections 
 

Layout Adjustment 
The view can be fine-tuned for optimal layout. Right click on the 
canvas, the following popup is shown: 
 

 
 
The Transport streams can be divided in 2 groups, for example 
Main or Backup. When adding a TS in the probe (refer to [1]), the 
checkbox “backup” indicates to which group a TS belongs. 
 
If “Split Main/Backup Streams” is left unchecked. No different 
groups are shown: 
 

 
 

 Renaming the groups 
Instead of “Main” and “Backup”, the operator can overrule the 
names for the groups: 
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Initially the TS names are copied from the names in the probe. In 
the ACC NOC view the TS Names can be overridden. Right click 
on a TS button, the following menu pops op: 
 

Overrule TS name 

 
 
When “Change Button Name” is selected, the operator can give 
another name to the specific transport stream. 
 

 
 

Refresh TS List Menu item “Tools”->”Refresh TS List” updates the TS Button 
overview. 
This is needed in order to manually refresh in case of new probes or 
transport streams are configured (and for some reason not detected 
automatically). 
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Current Alarm View 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The “Current Alarms” view shows all current alarms of the TS’s 
that are selected in the “TS Button” view. 
 

 
 
Visibility of alarm types can be configured by (un)checking alarm 
categories. 
The combo box “TS/Service” selects the TS or service that needs to 
be visible. 
The alarms can be sorted in different ways, by clicking a column 
header. 
 
The alarm messages are configurable. The user can enter specific 
message for each alarm line, refer to parameterized Log Lookup 
Table (LLT) configuration  
This way, it is possible to generate in the ACC NOC view another 
message than in the probe user interface (for example dependant of 
the operator’s role). 
 

Recorded View 
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The “Recorded” tab shows all recorded samples per transport 
stream and per service.  
 
 
 
 
 
                                                        = Refresh / reload files 
 
                                                        = Delete selected file 
 
The date and time of the sample is shown, and when a sample is 
selected, the media player on the following page shows the specific 
service sample. 
 

  
 
Additional information (creation date and time and file size) of the 
sample is shown in the box on the right part of the panel. 
Note that the recorded folder must be shared on the SMART Probe 
 

History View 
In the picture below, the history view is shown. All transport 
streams are listed in the left panel. When a TS is selected, in the 
panel on the right all alarms (counter alarms included) are shown.  
A sub selection is made by selecting or deselecting alarm categories 
and a date. The alarms are shown in pages of maximum 100 lines. 
The history is kept for one week. 
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The alarms can be sorted, by clicking a column header (Category, 
date time, service or message). 
 
The alarm messages are retrieved from the LLT database. 

 
 

 6. Reports 

Alarms report 
 
On the ACC, reports can be generated, by selecting “File”-
>”Report”. 
The following reports can be generated: 

 Alarms 
 Bitrate 
 Availability 
 Pid plan 
 Configuration 
 SCTE 35 

 

 
 
 
When “File->Report->Alarms” is selected, the alarm report dialog 
is shown. 
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The report output can be selected. The report can be shown on 
screen, or via a Word template (.dot) the report can be saved in a 
Word document. 
 
User templates can be created. They need to be saved in “<ACC 
Appdir>\Templates”.   
 
In “Report Input”, the operator can select whether a report of 
current alarms, or history (counter alarms included) is to be 
generated. 
 
The alarms can be selected per transport stream, or “All” (combo 
box Transport Stream). 
 
When “history” is selected, the user can specify an interval in time 
for the alarms to be reported. 
 
An example of report output is shown below 
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The ACC provides the possibility to export the pid plan as an 
exportable report, for use and reference external to the ACC. 
 

Bitrate report 
It is possible to generate bitrate reports for services and elementary 
streams, which can be exported for further use outside of the ACC. 
When  “File->Report->Bitrate” is selected, the following screen is 
shown: 
 

 
 
After selecting a probe from the probe list, all corresponding 
transport streams and analyzed services/components are shown. 
When a probe is selected, all corresponding pids are shown on the 
listbox on the right. It is possible to create a (sub) selection of the 
components in the report. The report output will be saved in an 
excel sheet. 
The “Period” date/time values indicate the interval for which the 
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bitrate data must be exported. 
 
Note 1: The ACC collects the bitrate data from the probe in 5 
minute intervals. So, it might happen that the most recent bitrate 
values are not available yet. 
 
Note 2: When the ACC has not run for a period in time, it collects 
all the probe bitrate data until 3 days backwards after start-up. It 
might take a couple of minutes before all the data is available 
within the ACC. 
 
 

Probe(s) selection 
The pull down menu will display all the connected probes 
You may select “All” or select a Probe  

Load list 
Retrieve an earlier stored Bitrate selection list  

Save list 
Save a created Bitrate list 

Autoselect pids 
Depending at the setting of the Pull down preselection, set the check 
marks 

Pull down selection  
Set the autoselect by type of component. 

 All (Pids) 
 None (clear all Pid selections) 
 Video (select only all video Pids) 
 Audio (select only all audio Pids) 
 ECM (select only all ECM Pids) 
 Video + Audio (select only all video + audio Pids) 
 Video + Audio + ECM (select only all video + audio + ecm Pids) 

 

 

 
 

Steps to operate auto 
Bit rate report 

 Select in the top line Probes the Probe(s) you want create a list 
 Select in pull down menu the component type(s) you want 
 Press Auto select Pids to mark all the check boxes 
 Save the list in your folder 
 Select in the Period box the start date and time of the wanted report 
 Select in the period box the end date and time of the wanted report 
 Press “Generate report”  
 Enter the report file path/folder and Name 
 Message window will appear with file path and name. Press OK
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 Close report window by selecting red cross on right top of the screen 
 Open the File (You will need Excel version from 2007) 

 
 

Example of Bitrate 
report 

 
 

Note:  
1. The excel file has several tabs below, showing the TS and Services 

information. 
2. The file is open for your own data retrieval. 
3. To let the Macro running properly you should have the macro function 

enabled in Excel properties. . 

 
 

Availability report 
It is possible to generate bitrate reports for services and elementary 
streams, which can exported for further use outside of the ACC. 
When  “File->Report->Availability” is selected, the following 
screen is shown: 

 
 

Probe(s) selection 
The pull down menu will display all the connected probes 
You may select “All” or select a Probe 

Period 
In the From selection the start date can be selected. 
In the To selection the end date can be selected. 
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Generate report 
This button will activate the report creation and will start the save 
dialog  

Example of 
Availability report 

 

 
Note:  

1. The file is open for your own data retrieval. 
2. To let the Macro running properly you should have the macro function 

enabled in Excel properties. 
 

Explanation 
Availability report 

 Probe:  Name of the Probe 
 Start date: Reports from date 
 End date: Report end date 
 Total time: Is the total reported time. Interval 
 TS/Srv: First row will show the TS info, in color. 

Below the stream will show the available Services 
 Run-mode: indicates the total operational Probe time 
 Monitor %: shows availability of the Probe the percentage 
 Config-mode:Shows the time that the Probe is not monitoring 
 Time A1: shows the time of the total A1 Alarm 
 Avail%: Indicates the availability of the A1 category A1 Alarm in 

percentages 
 High A2-A5: shows the time of the total A2-A5 Alarms were this is the 

highest Alarm 
 Time OK A1-5: Shows the time that the TS/SRV are not having any A1-

5 Alarms 
  Quality%: Is showing the Time OK in percentage 

 
 

Note: 
1. The table has more information hided. 

To unhide  the coulombs’ use function in excel 
 

 
 

PID report 
When “File->Report->Pid plan” is selected, the following screen is 
shown: 
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The pidplan is a dump of the current TS (contents) and the bitrate 
per component. 
All (PMT or other) references are shown.  Also the PSI/SI, NULLs 
and unreferenced pids are listed. 
 
The report can be generated in plain text format of as a CSV file. 
 
The list below shows an example of such a report. 
 

************************************ 
* PID plan 6-12-2010 14:47:55 
* TS : out 
* Total TS bitrate : 37992,409 kb/sec 
************************************ 
-------------------------- 
PSI:  
  PID 0 (0x0), table PAT, bitrate = 15,095 kbit/sec  
  PID 1 (0x1), table CAT, bitrate = 15,094 kbit/sec  
  PID 16 (0x10), table NIT, bitrate = 1,065 kbit/sec  
  PID 17 (0x11), table BAT/SDT, bitrate = 6,031 kbit/sec  
  PID 18 (0x12), table EIT, bitrate = 1507,665 kbit/sec  
  PID 20 (0x14), table TDT/TOT, bitrate = 0,319 kbit/sec  
-------------------------- 
 
-------------------------- 
Services:  
  Service 46 (0x2e) : ProSiebenSat.1, SAT.1 
      PMT PID = 106 (0x6a), bitrate = 20,973 kbit/sec, min = 18,674 kbit/sec, max = 21,327 
kbit/sec 
      Video Mpeg2 PID = 1791 (0x6ff), bitrate = 3815,027 kbit/sec, min = 3393,989 kbit/sec, 
max = 3844,209 kbit/sec 
      Mpeg Audio PID = 1792 (0x700), bitrate = 199,159 kbit/sec, min = 177,135 kbit/sec, 
max = 200,695 kbit/sec 



 

23 

SMART Gateway operation manual 

      Teletext PID = 34 (0x22), bitrate = 264,157 kbit/sec, min = 235,218 kbit/sec, max = 
265,973 kbit/sec 
      Total Service bitrate = 4278,343 kbit/sec 
  Service 40 (0x28) : BetaDigital, Home Shopping Europe 
      PMT PID = 104 (0x68), bitrate = 15,081 kbit/sec, min = 13,456 kbit/sec, max = 15,206 
kbit/sec 
      Video Mpeg2 PID = 1279 (0x4ff), bitrate = 3814,968 kbit/sec, min = 3393,852 kbit/sec, 
max = 3844,065 kbit/sec 
      Mpeg Audio PID = 1280 (0x500), bitrate = 199,191 kbit/sec, min = 177,135 kbit/sec, 
max = 200,695 kbit/sec 
      Total Service bitrate = 4014,159 kbit/sec 
  Service 47 (0x2f) : ProSiebenSat.1, N24 
      PMT PID = 107 (0x6b), bitrate = 20,965 kbit/sec, min = 18,674 kbit/sec, max = 21,248 
kbit/sec 
      Video Mpeg2 PID = 2047 (0x7ff), bitrate = 3814,956 kbit/sec, min = 3393,852 kbit/sec, 
max = 3843,922 kbit/sec 
      Mpeg Audio PID = 2048 (0x800), bitrate = 199,241 kbit/sec, min = 177,135 kbit/sec, 
max = 200,741 kbit/sec 
      Teletext PID = 36 (0x24), bitrate = 339,74 kbit/sec, min = 302,228 kbit/sec, max = 
342,431 kbit/sec 
      Total Service bitrate = 4353,937 kbit/sec 
  Service 898 (0x382) : ProSiebenSat.1, ProSieben 
      PMT PID = 100 (0x64), bitrate = 15,104 kbit/sec, min = 13,456 kbit/sec, max = 15,266 
kbit/sec 
      Video Mpeg2 PID = 255 (0xff), bitrate = 3897,796 kbit/sec, min = 3466,903 kbit/sec, 
max = 3927,27 kbit/sec 
      Mpeg Audio PID = 256 (0x100), bitrate = 204,448 kbit/sec, min = 181,941 kbit/sec, max 
= 206,003 kbit/sec 
      AC3 PID = 257 (0x101), bitrate = 471,846 kbit/sec, min = 419,906 kbit/sec, max = 
475,415 kbit/sec 
      Teletext PID = 32 (0x20), bitrate = 301,898 kbit/sec, min = 268,448 kbit/sec, max = 
304,271 kbit/sec 
      Total Service bitrate = 4875,988 kbit/sec 
  Service 899 (0x383) : ProSiebenSat.1, KABEL1 
      PMT PID = 101 (0x65), bitrate = 20,887 kbit/sec, min = 18,489 kbit/sec, max = 21,153 
kbit/sec 
      Video Mpeg2 PID = 511 (0x1ff), bitrate = 3814,894 kbit/sec, min = 3393,989 kbit/sec, 
max = 3843,778 kbit/sec 
      Mpeg Audio PID = 512 (0x200), bitrate = 199,282 kbit/sec, min = 177,135 kbit/sec, max 
= 200,982 kbit/sec 
      Teletext PID = 33 (0x21), bitrate = 226,436 kbit/sec, min = 201,576 kbit/sec, max = 
227,952 kbit/sec 
      Total Service bitrate = 4240,612 kbit/sec 
  Service 900 (0x384) : BetaDigital, DSF 
      PMT PID = 103 (0x67), bitrate = 15,094 kbit/sec, min = 13,322 kbit/sec, max = 15,206 
kbit/sec 
      Video Mpeg2 PID = 1023 (0x3ff), bitrate = 3814,988 kbit/sec, min = 3393,852 kbit/sec, 
max = 3844,209 kbit/sec 
      Mpeg Audio PID = 1024 (0x400), bitrate = 199,18 kbit/sec, min = 177,135 kbit/sec, max 
= 200,552 kbit/sec 
      Total Service bitrate = 4014,168 kbit/sec 
  Service 897 (0x381) : BetaDigital, tm3 
      PMT PID = 102 (0x66), bitrate = 15,091 kbit/sec, min = 13,322 kbit/sec, max = 15,206 
kbit/sec 
      Video Mpeg2 PID = 767 (0x2ff), bitrate = 3814,874 kbit/sec, min = 3393,852 kbit/sec, 
max = 3843,635 kbit/sec 
      Mpeg Audio PID = 768 (0x300), bitrate = 199,19 kbit/sec, min = 177,135 kbit/sec, max 
= 200,618 kbit/sec 
      Teletext PID = 35 (0x23), bitrate = 264,279 kbit/sec, min = 235,081 kbit/sec, max = 
266,542 kbit/sec 
      Total Service bitrate = 4278,343 kbit/sec 
-------------------------- 
 
 
-------------------------- 
Ghost PIDs:  
  PID = 8186 (0x1ffa), bitrate = 6439,381 kbit/sec, min = 5727,091 kbit/sec, max = 
6496,293 kbit/sec 
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Configuration report 
When “File->Report->Configuration” is selected, the following 
screen is shown: 
 

 
 
The configuration is a dump of the current probe configuration 
(transport streams, services, components and their alarm settings). 
 
Example configuration: 
******************************************************************************** 
Configuration for TS : ff  
------------------------------------------------------------------------------- 
        TS_sync_lost Alarm1 B Num Occ:1 per Period: 1 ms  
        Sync_byte_error Alarm1 B Num Occ:1 per Period: 1 ms  
        PAT_error Alarm1 B Num Occ:1 per Period: 1 ms  
        PMT_error Alarm1 B Num Occ:1 per Period: 1 ms  
        Transport_error Alarm1 B Num Occ:1 per Period: 1 ms  
        CRC_error Alarm1 B Num Occ:1 per Period: 1 ms  
        CAT_error Alarm1 B Num Occ:1 per Period: 1 ms  
        NIT_error Alarm1 B Num Occ:1 per Period: 1 ms  
        Unreferenced_PID Alarm1 B Num Occ:1 per Period: 1 ms  
        SDT_error Alarm1 B Num Occ:1 per Period: 1 ms  
        EIT_error Alarm1 B Num Occ:1 per Period: 1 ms  
        EIT_pf_error Alarm1 B Num Occ:1 per Period: 1 ms  
        TDT_error Alarm1 B Num Occ:1 per Period: 1 ms  
 
        PAT Alarm2 B threshold1: 25 ms threshold2:500 ms  
        PMT Alarm2 B threshold1: 25 ms threshold2:500 ms  
        BAT Alarm2 B threshold1: 25 ms threshold2:12000 ms  
        CAT Alarm2 B threshold1: 25 ms threshold2:12000 ms  
        SDT Alarm2 B threshold1: 25 ms threshold2:2000 ms  
        SDT oth Alarm2 B threshold1: 25 ms threshold2:20000 ms  
        NIT Alarm2 B threshold1: 25 ms threshold2:20000 ms  
        NIT oth Alarm2 B threshold1: 25 ms threshold2:20000 ms  
        EITpf Alarm2 B threshold1: 25 ms threshold2:10000 ms  
        EITpf oth Alarm2 B threshold1: 25 ms threshold2:30000 ms  
        EITsch Alarm2 B threshold1: 25 ms threshold2:30000 ms  
        EITs oth Alarm2 B threshold1: 25 ms threshold2:300000 ms  
        TOT Alarm2 B threshold1: 25 ms threshold2:60000 ms  
        TDT Alarm2 B threshold1: 25 ms threshold2:60000 ms  
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        EMM check Alarm2 B Num Occ:1 per Period: 1 ms  
        Ghost ECM/EMM Alarm2 B Num Occ:1 per Period: 1 ms  
        Srv not analyzed Alarm2 B Num Occ:1 per Period: 1 ms  
        Min TS bitrate Alarm2 B threshold1: 5000 Kbits threshold2:0 minutes  
        Max TS bitrate Alarm2 B threshold1: 50000 Kbits threshold2:0 minutes  
        RF Level Alarm2 B threshold: 200 * 0.1 dBmV  
        SNR Alarm2 B threshold: 100 * 0.1 dB  
        BER Alarm2 B threshold: 1 *E-6  
 
 
------------------------------------------------------------------------------- 
Service SrvID=1 Name=TBN HD 
        Min bitrate Alarm1 A threshold1: 0 Kbits threshold2:0 minutes  
        Max bitrate Alarm1 A threshold1: 0 Kbits threshold2:0 minutes  
        Events EITpf Alarm1 B threshold: 30 sec (max gap)  
        EIT sched Alarm1 B threshold1: 30 sec (max gap) threshold2:24 hours  
        PCR repetition Alarm1 C threshold: 40 ms Num Occ:1  Period: 1 ms  
        PCR discontinuity Alarm1 C threshold: 100 ms Num Occ:1  Period: 1 ms  
        PCR accuracy Alarm1 C threshold: 500 ns Num Occ:1  Period: 1 ms  
    Video PID=257 
        Black Frames Alarm2 B threshold: 4 Iframes  
        Freezed Frames Alarm2 B threshold: 4 Iframes  
 
 
------------------------------------------------------------------------------- 
AnalyzedComponents:  
 
******************************************************************************** 
 

 

Log Lookup Table 
The log lookup table can be used to create used defined alarm 
messages per alarm ID. User defined messages can help NOC 
operators and technicians to better understand an error in the 
context of their specific environment.  
 
Select menu item “Tools”->”Log Lookup Table”.  
 

 
 

This function shows the Log Lookup Table (LLT). 
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Parameterized 
messages 

In this view, the “UserMessage” column can be edited. The user can 
generate a specific message per (counter) alarm. 
 
Each alarm can have up to 5 parameters. These parameters are 
indicated by %1, %2,%3,%4 and %5. In the SystemMessage, the 
operator can see what the parameter should be. The order in which 
they occur in the UserMessage does not have to be the same is in 
the SystemMessage. The parameters are passed via string values. 
 
 
For example, 
 
SystemMessage: Service Bitrate = %1 Kbits (too high, max=%2 
Kbits) 
UserMessage: The service bitrate, which is max %2 Kbits is 
exceeded (bitrate = %1 Kbits). 
 
Output: 
The service bitrate, which is max 3.500 Kbits is exceeded (bitrate = 
3.100 Kbits). 
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 7. Settings 

Acc Server settings 
Select “Tools”->”Settings”. 
 

 
 

In this menu the tab options allow configuration of global ACC 
system parameters. 
 

 
 
The field “Client/Server XML directory” specifies the file based 
interface to the probes. This directory must match the directory 
specified in the probes. 
 
The Probes that are connected via the file based interface, are listed 
in “Probe IP address”. An indication “State” shows the status of the 
probe. 
 

 
Removing Probe from 

ACC configuration 
 

Click “Remove”, in order to remove a probe from the ACC. 
Note: Please be aware that the probe must not currently be running, 
or re-started afterwards, because it will add itself again to the probe 
list in the acc by writing interface files into the xml directory 
(probe-acc interface) 
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Server tab 
In tab “Server”, an IP address and port must be configured. This 
will be the IP address:port combination from which the ACC will 
communicate with the probes. The default port number is 1035. 
 

 
 
The port must be a free port on the ACC Server system. 
 
The Combobox lists all NICs that are configured on the ACC 
system. 
 

Colors tab 
In tab “Colors”, the alarm colour settings are configured. 
 

 
 
Per alarm category (priority), the text and background colours are 
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configured. The “preview box” shows a preview of the current 
setting. 
 
Also the colour setting for the “probe offline” message is 
configured here.  

 

Logging tab 
In tab “Logging” the location of the LLT (XML) file is configured. 
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Email tab 
In tab “Email”, the Email settings are configured. 
 

 
 

Enable SMTP: Enables the email services. When this checkbox is 
checked, the settings are enabled. 
 
SMTP Server: Defines the email server which is used to send the 
emails. 
 
Subject: Defines the title of each email message 
 
MailForm: Defines the sender of the email 
 
Use Credentials: Checkbox that must be ticked when the 
destination e-mail server requires authentication. If authentication is 
requires, the account and password details have to be filled. 
 
Port: Sets out-going TCP port 
 
 SSL check box: Enables SSL security. 
 
Time slots: 5 different timeslots can be defined. Per slot, the 
alarm level and category can be selected. “Kind of day” defines a 
working day (Monday- Friday), weekend or special day. The special 
day configuration (Christmas, New-year, etc.) can be defined by 
clicking button “Special Days”. 
 
Mailbox: Per timeslot a mailbox target can be configured. An 
email address can be entered her. Multiple addresses are allowed, 
separated width “,”; 
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Display: HTML Layout: Defines the layout of the email. Note 
that the content of the email also depends on this value. 
 
 

 
Example email: see next page 

 

 

 

 
 
 
 
 

 

Van: report@example.com 
[mailto:report@example.com] 
Verzonden: do 27-10-2011 0:54 
Aan: R&D Report 
Onderwerp: Report Alarm : TP 3222 - EDL2 
ALARM3 Audio silence on pid 90 new: 1 new/solved: 1 
ongoing: 2 
TimeSlot 4   
 
New: 
10-27-11 
    type: ALARM3  ex:A 
   00:00:37  
    TP 3222 - EDL2 
    Audio silence on pid 90 
    Duration : 54 min 12 sec 
 
Ongoing: 
10-26-11 
    type: ALARM5  ex:A 
   13:29:10  
    TP1119-S - Man-X 
    Bitrate PID 250 (No valid Type) = 0.000 Kbits (too low, 
min=2.000 Kbits) 
    Duration : 11 hour 25 min 39 sec 
 
10-26-11 
    type: ALARM5  ex:A 
   13:29:10  
    TP1119-S - Radio 1 
    Bitrate PID 250 (No valid Type) = 0.000 Kbits (too low, 
min=2.000 Kbits) 
    Duration : 11 hour 25 min 39 sec 
 
Countered: 
Current Alarms: 
10-27-11 
    type: ALARM3  ex:A 
   00:00:37  
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Bitrate report tab 
 
 
Enable: Enables the auto report services. When this 

checkbox is checked, the settings are enabled.  
 
When:   Defines the Daily or Weekly auto report  
creating time/date   
 
Pull down box: In Weekly mode the report day can be 
selected 
 
Time:  Defines the time when creating the report. 
  
PID list: Please enter the file path of the created Pid 

list 
 
Output dir: Please enter the file path for storage of the 

created auto report based on the Pid list. 
 
Pid list: Please enter the file path of the created Pid 

list 
 
Generate now: Press button to overwrite the time function 

and create instantly a Bitrate report according 
the Pid list. 

 
 
 
Send autoreport by mail: When Enabled the system will 
send an Email to the address(es) in the email to box.  
 
Emailbox: Per timeslot a mailbox target can be configured. An 
email address can be entered her. Multiple addresses are allowed, 
separated width “,”. 
 
Generate and mail now: Pressing the button will instantly 

generate Bitrate report. 
 
Note:  

1. This function will only work if the Enable SMTP is checked. This check 
box is in tab “Email” 

2. The Report format is in Excel file XLSX (Excel 2007 and higher) 
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Availability report tab 
In tab “Availability reports”, the dedicated E-mail and auto report 
settings are configured. 
 
Enable: Enables the auto report services. When this 

checkbox is checked, the settings are enabled.  
 
When:   Defines the Daily or Weekly auto report 
creating time/date   
 
Pull down box: In Weekly mode the report day can be 
selected 
 
Time:  Defines the time when creating the report 
 
Output dir: Please enter the file path for storage of the 

created auto report based on the Availability 
report settings. 

 
Generate now: Press button to overwrite the time function 

and create instantly a Bitrate report according 
the Availability report settings. 

 
 
 
Send autoreport by mail: When Enabled the system will 
send an Email to the address(es) in the email to box.  
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Email to box: Per timeslot a mailbox target can be 
configured. An email address can be entered here. Multiple 
addresses are allowed, separated width “,”. 
 
Generate and mail now:Pressing the button will instantly 

generate Availability report. 
 
Note:  

3. This function will only work if the Enable SMTP is checked. This check 
box is in tab “Email” 

4. The Report format is in Excel file XLSX (Excel 2007 and higher) 
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  8. TS/Services 
View TS/Services 

 
 

 
 
 
Menu item “TS/Services”, opens exactly the same user interface as 
on the probe. 
The only difference is the visibility of multiple (all) probes in the 
panel on the left. 
 

 
 
The TS/service configuration is editable on the ACC Server.  
 
Restriction: Some functions related to specific form settings are not 
possible on the ACC, like Multi-viewer (form) settings, show 
display (form) setting, etc. 
 

Admin mode 
 

The ACC user interface runs default in viewer mode. The alarm 
settings cannot be changed. The checkbox “Admin” must be 
selected to run the ACC in admin mode. This mode enables 
configuration of the alarms from ACC. 
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A password is needed to select “Admin” mode. The default 
password is “smart”. 
 

 
 
 

Help 
 

 
The Help menu only consists of an “About” function. 

 

 
 

About 
 
Shows software release version. 
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 9. DVB Tables 

Table ID values All DVB tables have unique table_id values. There are as follows: 
 
Value  Description 
0x00  program association table 
0x01  conditional access table 
0x02  program map table 
0x03  transport stream description table 
0x04 - 0x3F  reserved 
0x40  network information table – actual network 
0x41  network information table – other network 
0x42  Service description table – actual transport stream 
0x43 - 0x45  reserved for future use 
0x46  service description table – other transport stream 
0x47 - 0x49 reserved for future use 
0x4A  bouquet association table 
0x4B - 0x4D  reserved for future use 
0x4E  event information table – act. transport stream, present/following 
0x4F  event information table – other transport stream, present/following 
0x50 - 0x5F  event information table – actual transport stream, schedule 
0x60 - 0x6F  event information table – other transport stream, schedule 
0x70  time date table 
0x71  running status table 
0x72  stuffing table 
0x73  time offset table 
0x74 - 0x7D  reserved for future use 
0x7E  discontinuity information table 
0x7F  selection information table 
0x80 - 0xFE  user defined 
0xFF  reserved 

  

Valid PIDs The following PIDs are valid: 

  

Table name: Table_id PID 

Program association table 0x00 0x00 

Program map table  0x02  as specified in PAT 

Conditional access table  0x01  0x01 

Network information table  0x40-0x41  0x10 

Service description table  0x42 or 0x46  0x11 

Event information table  0x4E-0x6F  0x12 

Bouquet association table  0x4A  0x11 

Time and date table  0x70  0x14 

Time offset table  0x73  0x14 
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 Tables and descriptors are described in more detail below. 

  

  

Program Association 
Table (PAT) 

This is an MPEG defined PSI table like the PMT and CAT. The other 
tables are SI tables and defined by DVB. Each Transport Stream has 
an own PAT. The PAT is always transmitted on PID 0x00. The PAT 
provides a list of the programs present in the Transport Stream. For 
each program the PAT contains a program number which is the same 
as the Service_ID as defined by DVB and present in the SDT. The 
PAT contains a different PID for each program, which is  the PID of  
the Program Map Table  (PMT) belonging to that particular program. 
The PAT doesn’t have descriptors.  

  

Program Map Table 
(PMT) 

Each  Program  has  an  own  PMT.  Each  PMT  is  transmitted  on  a 
different PID in the range from 0x20 to 0x1FFE. The PMT provides a 
list of components and their PIDs that are part of the program. For 
each component a stream type is transmitted. The PMT includes also 
the PCR_PID. 

  

Conditional Access 
Table (CAT) 

Each Transport Stream transmits one CAT on PID 0x00. It includes 
the CA_descriptor, which is the only mandatory descriptor in this 
table. The CA_descriptor conveys for each CA System the 
CA_System_id and the EMM_PID. A private_data_specifier_ 
descriptor is optional.  

  

Network Information 
Table (NIT) 

The NIT conveys information relating to the physical organization of 
the multiplexers/TSs carried via a given network, and the 
characteristics of the network itself.  The  combination  of  
original_network_id  and transport_stream_id  allow  each  transport  
stream  to  be  uniquely identified throughout the ETS application area. 
Networks are assigned individual network_id values, which serve as 
unique identification codes for networks.  In  the  case  that  the  NIT  
is  transmitted  on  the network on which the transport stream was 
originated, the network_id and the original_network_id shall take the 
same value. 

  

Service Description 
Table (SDT) 

Each sub-table of the SDT describes services that are contained within 
a particular transport stream. The services may be part of the actual 
transport  stream  or  part  of  other  transport  streams,  these  being 
identified by means of the table_id. 

  

Event Information Table 
(EIT) 

The  EIT  provides  information  in  chronological  order  regarding  
the events contained within each service.  
 
Four classifications of EIT have been identified, distinguishable by the 
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use of different table_ids: 
1. Actual TS, present/following event information = table_id = "0x4E"; 
2. Other TS, present/following event information = table_id = "0x4F"; 
3. Actual TS, event schedule information = table_id = "0x50" to "0x5F"; 
4. Other TS, event schedule information = table_id = "0x60" to "0x6F".  
 
All EIT sub-tables for the actual transport stream shall have the same 
transport_stream_id and original_network_id values.  
 
The present/following table shall contain only information pertaining 
to the present event and the chronologically following event carried by 
a given service on either the actual transport stream or another 
transport stream,  except  in  the  case  of  a  Near  Video  On  Demand  
(NVOD) reference service where it may have more than two event 
descriptions. The  event  schedule tables  for  either  the actual  
transport  stream  or other  transport  streams  contain  a  list  of  
events,  in  the  form  of  a schedule, namely, including events taking 
place at some time beyond the  next  event.  The  EIT  schedule  tables  
are  optional.  The  event information shall be chronologically ordered. 

  

Time and Date Table 
(TDT) 

The TDT carries only the UTC time and date information 

  

Bouquet Association 
Table (BAT) 

The  BAT  provides  information  regarding  bouquets.  A  bouquet  is  
a collection of services, which may traverse the boundary of a 
network. 

  

Time Offset Table (TOT) The TOT (see: table 9) carries the UTC-time and date information and 
local time offset. 
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10. Definitions, Acronyms and 
abbreviations 

 
Abbreviation Term Definition 
CA Conditional Access Collection of system components that make sure 

that entitled subscribers have access to the broadcast 
products and not entitled subscribers have no 
access.  

ECM Entitlement Control 
Message 

Conditional Access message describing in a secure 
way how the components of a broadcast product are 
scrambled. 

ECM Stream  Transports  all  the  ECMs  belonging  to a  service. 
The  ECM stream ID  (0  -  65535) identifies to 
which ECM Stream the ECMs of a service are sent. 
One or more services can be assigned to the same 
ECM stream. See also: SCG. 

ECMG Entitlement 
Management Message 
Generator 

Generates ECMs based on the received control 
words and access criteria. 

EIS Event Information 
Scheduler 

Stores all CA-specific information required for the 
complete head-end  system.  The  complete  
functionality  of  the  EIS  is implemented in CAPS. 
See also: CAPS. 

EMM Entitlement 
Management Message 

Conditional Access message containing a secure 
command for one or more smart cards. 

Encryption  The process of rendering a digital signal, 
unintelligible to any receiver that does not have 
some unique piece of information needed to recover 
the signal.  

EPG Electronic Program 
Guide 

Application software in the subscriber’s receiver 
that allows the content provider to promote the 
selling of his services and events and that helps the 
subscriber to select these products. 

Event  Grouping of elementary broadcast data streams with 
a defined start and end time belonging to a common 
service, e.g. first half  of  a  football  match,  News  
flash,  first  part  of  an entertainment show.  

IRD Integrated Receiver and 
Decoder 

Receiver  and  decoder  of  digital  TV  services.  
Either  a consumer   set-top   box   or   a   receiver   for   
professional applications (“Commercial IRD”). 

MPEG-2 Motion Picture Experts 
Group 

Refers to the standard ISO/IEC  13818-1. Systems 
coding is defined in part one. 

Multiplex  Stream  of  all  the  digital  data  in  a  single  physical  
channel carrying one or more services or events 

MUX Multiplexer Head-end component that performs time multiplexing 
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of input data  and  outputs  an  MPEG-2  transport  
stream.  The  exact functionality of a MUX is 
implementer specific.  
 

Network  Transportation  medium  for  multiple  transport  
streams.  See also: Transport Stream.  

PSI Program Specific 
Information 

Data  structures  defined  in  the  DVB  standard  to  
describe programs in a digital broadcast application 

Scrambling  In  data  transmission,  scrambling  refers  to  the  
process  of randomizing the bit pattern of a 
transmitted signal to prevent peaks in the spectrum of 
the modulated signal. The television industry usually 
uses the term  ‘encryption’ for program denial of 
digital signals.  

Service  The content provider offers services to the subscriber. 
A key set, product type and service number uniquely 
identifies every service.  

Service schedule  Timing  and  Conditional  Access  information  
assigned  to  a service,  which  is  used  to  schedule  a  
service  as  part  of  a timetable.  

Set-top box  A box for consumer/subscriber purposes with an 
Integrated Receiver and Decoder for digital TV 
services. See also: IRD.  
 

Smart card  Secure device (credit card format) used in receiver. 

Transport 
Stream 

 Data structure defined in ISO/IEC 13818-1. It is the 
basis of the   ETSI   digital   video-broadcasting   
standard.   Multiple transport streams constitute a 
network.  

Service Type  Method  to  categorize  the  program  types  on  a  
service.  A unique number  (0 -255) identifies the type 
of program. See also: Type/Version. 

 


